
EXPERIMENT 16: IDENTIFICATION AND QUANTITATIVE ANALYSIS OF A 

MONOPROTIC ACID BY A POTENTIOMETRIC TITRATION 
 

OBJECTIVES 

o Use a pH probe to measure the pH during the titration of an unknown weak monoprotic 

acid. 

o Use a drop counter to deliver titrant to the analyte solution. 

o Determine the molar mass of an unknown weak monoprotic acid. 

o Determine the Ka value(s) for an unknown weak monoprotic acid. 

o Confirm the identity of the monoprotic acid through titration data collected 

o Understand the reactions and the composition of a solution during a titration. 

In this experiment, you will receive a pure sample of a weak monoprotic acid to analyze. 

INTRODUCTION 
If we examine a solution of hydrochloric acid, we would find that the acid is completely dissociated, and 

is therefore a strong acid.  On the other hand, careful observation of a solution of acetic acid shows that 

most of the acetic acid molecules do not dissociate and the acid is weak.   Knowing the equilibrium 

constant and concentration of an acid is invaluable in determining the amount of dissociation observed.    

Similar observations can be made for bases. 

For the titration of a weak acid, the initial pH is determined by the acid’s concentration and the amount it 

dissociates.  Pre-equivalence point pH values are determined from the quantities of undissociated weak 

acid and conjugate base left after the addition of a given volume of the standard base; at these volumes we 

have a buffer solution.   At the equivalence point, the weak acid has been completely converted to its 

weak conjugate base, and the concentration and amount of dissociation of this base determines the pH.   

After the equivalence point, the pH is determined by the excess strong base that is added.   

NOTE: In a solution containing several acids, the stronger will control the pH.  A similar 

statement made be made about solutions of bases. 

With this knowledge, one can determine the pH during a titration as a function of volume of titrant added; 

a plot of pH versus titrant added is called a titration curve.   Understanding the shape of the titration curve 

assists in identifying the acid, selecting a visual indicator, quantitating the acid and even determining if a 

qualitative or quantitative analysis of the acid is even possible.  

We mostly speak of the relative acidities of acids and bases based upon their pKa which is defined by the 

equation: pKa = -log Ka°. Here Ka° is the thermodynamic acid dissociation constant for the reaction: 

𝐻𝐴(𝑎𝑞) + 𝐻2𝑂(𝑙) ⇌ 𝐴−(𝑎𝑞) + 𝐻3𝑂+(𝑎𝑞) 

In the following derivation, 𝑎𝐴− , [A-], and 𝛾𝐴−  represent, respectively, 

the activity, the molar concentration, and the activity coefficient of the 

conjugate base, A-.   Each species in the equilibrium will have similar 

quantities. 

  



The thermodynamic acid dissociation constant can be written for this dissociation as: 

𝐾𝑎
𝑜 =

𝑎𝐴−𝑎𝐻3𝑂+

𝑎𝐻𝐴
 

Since the activity of each species is dependent on its molar concentration and activity coefficient, e.g.  

𝑎𝐴− = 𝛾𝐴−[𝐴−], it can then be shown that: 

𝐾𝑎
𝑜 =

𝛾𝐴−[𝐴−]𝛾𝐻3𝑂+[𝐻3𝑂+]

𝛾𝐻𝐴[𝐻𝐴]
=

𝛾𝐴− ∙ 𝛾𝐻3𝑂+

𝛾𝐻𝐴
∙

[𝐴−][𝐻3𝑂+]

[𝐻𝐴]
 

Since pKa° ≡ - log Ka° we can write: 

𝑝𝐾𝑎
𝑜 =  −[log(𝑎𝐴−) + log(𝑎𝐻3𝑂+) − log (𝑎𝐻𝐴)] 

By definition we know that 𝑝𝐻 = −log (𝑎𝐴−) 

𝑝𝐾𝑎
𝑜 =  𝑝𝐻 + log (𝑎𝐻𝐴) − log(𝑎𝐴−) 

Rearranging using logarithm rules we get: 

𝑝𝐾𝑎
𝑜 =  𝑝𝐻 − log (

𝑎𝐴−

𝑎𝐻𝐴
)   

After expanding the activity terms and collecting terms: 

𝑝𝐾𝑎
𝑜 =  𝑝𝐻 − log (

[𝐴−]

[𝐻𝐴]
∙

𝛾𝐴−

𝛾𝐻𝐴
) 

We can now assume that 
𝛾𝐴−

𝛾𝐻𝐴
≅ 1 and rearranging we get: 

𝑝𝐻 =  𝑝𝐾𝑎
𝑜 + log (

[𝐴−]

[𝐻𝐴]
) 

This is the famous Henderson-Hasselbalch equation.   This equation can be applied to most (but not all!) 

buffer regions for titrations curves of 1) monoprotic acids, 2) polyprotic acids, 3) monobasic bases and 4) 

polybasic bases.  A solution is a buffer is has the greatest buffer capacity when conjugate pairs are of 

similar concentrations.   When the concentrations of conjugates are equal, the pH should equal the pKa°.  

This value can be determined from the titration curve by taking the pH half-way to the endpoint or break.   

This, of course, also indicates that any equilibrium constant derived from the titration data will deviate 

from the listed values because these standard reference values represent thermodynamic constants at an 

ionic strength of zero.   It is fraught with other assumptions as well, so be mindful of this. 

  



TYPE OF ACIDS 
The discussion now leads into some specifics relative to the identification of an acid from its titration 

data.  Use this information to confirm the identity of your samples both on this experiment and the next.   

You will need to prove the identity using multiple pieces of data, not just one. 

A monoprotic acid: 

A monoprotic acid titration curve is of sigmoidal shape and shows one endpoint or break.   The endpoint 

volume for the titration is determined at the inflection point in the curve.  The inflection point can be 

found by taking the second derivative of the titration curve d2(pH/V).   Let’s take the example of 10.0 

mL of 0.1000 F benzoic acid, Ka° = 6.3x10-5, being titrated with 0.2000 F NaOH: 

  

 

The endpoint volume for this data is at 5.0 mL.  You should confirm this by calculating it yourself!.   

Note that at the inflection point the derivative changes sign.  If you take the highest point and the lowest 

point at the inflection point, you can find the x-value where the second derivative crosses the x-axis.  This 

is done via linear interpolation.  This is the endpoint.  Given the mass of the acid and the volume of 

NaOH required to titrate it (the endpoint), you can calculate the acid’s molar mass.   The pKa° can also be 

extracted from the curve by realizing that at the 50% titrated point, 2.5 mL, the concentration of 

undissociated acid is equal to the concentration of the conjugate base.  Assuming the ratio of activity 

coefficients is 1, we can see that the pH at this point will be equal to the pKa°.    

𝑝𝐻50% =  𝑝𝐾𝑎
𝑜 + log (

[𝐴−]

[𝐻𝐴]
) = 𝑝𝐾𝑎

𝑜 + log(1) = 𝑝𝐾𝑎
𝑜
 

In this case it’s about 4.2 which is close to the correct value.  You can also find the pKa at 25% and 75% 

titrated.  For 25% titrated we have converted 1 part of the HA into A-.  That leaves 3 part of HA left.  

Plugging these ratios into the Henderson-Hasselbach equation, we get: 

  

𝑝𝐻25% =  𝑝𝐾𝑎
𝑜 + log (

[𝐴−]

[𝐻𝐴]
) = 𝑝𝐾𝑎

𝑜 + log (
1

3
) = 𝑝𝐾𝑎

𝑜 − 0.477 

Another characteristic of a monoprotic acid that distinguishes it between a diprotic acid with two distinct 

breaks is that the pH difference between 75% and 25% titrated is about 0.954 pH units and no more.  The 

derivation of this can be found in the Appendix I. 

  



A Diprotic Acid with two distinct breaks:  

A diprotic acid titration curve also is of a sigmoidal shape, but can show one or two endpoints or breaks.   

Again, the endpoints for the titration are found at the inflection point(s) in the curve.  Let’s take the 

example of 10.0 mL of 0.0500 F sulfurous acid, Ka1° = 1.7x10-2 and Ka2° = 6.4x10-8, being titrated with 

0.1000 F NaOH: 

 

It is clear that the two protons from the acid are being titrated: the strongest from 0 to 5.0 mL (buffer 

region #1) and the second from 5.0 to 10.0 mL (buffer region #2).  The endpoints are Ve1 = 5.0 ml and Ve2 

= 10.0 mL, and it is noteworthy that Ve2 is twice Ve1.  This can only occur with a diprotic acid OR an 

equimolar mixture of monoprotic acids.    It is obvious in this titration that the pH difference between 

75% and 25% titrated for the titration of both protons is much greater than 0.954 (see monoprotic acid 

curve).  However, if you look at 25% and 75% titrated for EACH proton the difference will be about 

0.954 pH units (for instance, when titrated the second proton the difference in pH between 8.25 mL and 

6.25 mL is ~ 0.954).  This occurs in the buffer regions where two conjugates are present indicating that 

the Ka° values of the two protons must differ by at least 103 to 104. 

Either of the endpoint volumes can be used for quantitation, e.g. to find the mass of the acid present or its 

molar mass.   Usually the clearest/sharpest endpoint is used and this can vary from acid to acid (see next 

example!), and depends on the relative Ka° values.   IMPORTANT: You have to consider the 

stoichiometry of the reaction based on the endpoint you select when you do these calculations. 

The pKa° values can also be extracted from the curve by realizing that at the 50% titrated point in each 

buffer reaction (2.5 mL and 7.5 mL in this case), the concentration of conjugates making up the buffer are 

equal.  Assuming the ratio of activity coefficients is 1, we can see that the pH at this point will be equal to 

the pKa° as with a monoprotic acid.  

 

  



A diprotic acid with one apparent break:  

As the Ka° values of a diprotic acid approach each other you are less likely to see two distinct breaks.  

This can also happen if the second pKa
° approaches 10 or larger.   This make identification much harder.     

Let’s take the example of 10.0 mL of 0.0500 F isophtalic acid, Ka1° = 2.8x10-4 and Ka2° = 2.5x10-5, being 

titrated with 0.1000 F NaOH: 

 

 

This is a diprotic acid, but it only has one endpoint at 10.0 mL.    This can be easily mistaken for a 

monoprotic acid, but the molar mass will be incorrect.  Plus, the difference between 75% and 25% titrated 

is much larger than 0.954.  Nailing down the individual pKa° values is a challenge.  How will you get any 

equilibrium constant data out of this titration curve?  This behavior occurs when the acid’s pKa°s differ by 

less than 4 (4 orders of magnitude).  The closer they are, the less distinct the first endpoint will be 

resulting in a curve with one endpoint or break. 

Other diprotic variations can be observed.  The shape of the curve will depend on the difference in the 

pKa° values and their values.  It is difficult to see breaks that occur at very high pH values because the 

solution is becoming dilute and more error is introduced into measuring the pH by the glass electrode at 

these values. 

You can take what you have learned with monoproticc and diprotic acids and apply it a titration analysis 

in the nest lab. 

The astute student should also realize that the salt made from the conjugate of a monoprotic acid or a 

diprotic acid can also be titrated.  Example include sodium benzoate, sodium sulfite, sodium hydrogen 

sulfite and sodium hydrogen carbonate.  Note that the latter two are amphiprotic and can be titrated with 

an acid or a base! 

ACID INDICATORS: 

We will also add some indicators to the titrations you do and try to experimentally select the best visual 

indicator for each situation.  Visual indicators are selected based on the pH at the endpoint of interest.  It 

is usually best if the pH at the endpoint is within the color change range for the indicator. 

 

  



PRE-LAB ASSIGNMENT: 

As you make observations, enter them in your lab notebook. 

Go to the lab eLC site and download the EXCEL file ‘Monoprotic Acid Titration Curve.’    Open the file 

in EXCEL.   You are presented with a titration curve for a monoprotic acid under the following initial 

conditions:   

Acid Concentration: 0.0200 F Acid Volume: 20.00 mL Ka°: 1.00E-1 

Base Concentration: 0.0100 F  

This high value of the Ka° effectively mimics a strong acid strong base titration.   Ask yourself these 

questions: 

 1.  Does the shape of the curve make sense for a monoprotic acid?  Explain. 

2. From the graph what is the equivalence* point volume?   Do the calculation to make sure 

you understand.  * We use equivalence point instead of endpoint because this curve is 

calculated in theory. 

3. What species are in the solution at 0%, 50%, 100% and 110% titrated.  Possible species 

include HA, A-, H3O+, and OH- (ignore water and other spectator ions). 

4. Decrease the Ka° incrementally by an order of magnitude, i.e from 0.1 to 0.01.   Does the 

overall shape of the curve change?  Does the quality equivalence point break change?  

Explain. 

5. Set the Ka° to about 1E-5 (typical for carboxylic acids) and change the acid concentration 

and observe.  Then reset the acid concentration and change the base concentration and 

observe. 

6. Does changing the volume of acid have a similar effect to any of the other variables? 

 

PROCEDURE 

- Attend a demonstration of the apparatus by your TA. 

This is a guided inquiry procedure.  You will have to do calculations as you go along. 

1.  You will receive a sample of a monoprotic weak acid.   Get a 250 mL beaker and a stir bar.   Label 

the beaker with a unique identifier.   

2. Write the reaction between a general monoprotic acid, HA and sodium hydroxide (titrant).  Show all 

states of matter.  What is the stoichiometry between the acid and the titrant? 

3. Assume that the molar mass of your acid is about 100 g/mol.   You are provided with 0.1000 F NaOH 

as a titrant.  What mass of your sample should you weigh out to use about 10 mL of your base titrant?   

 



4. Weigh this mass to 4 decimal places (don’t weigh less than the mass or greater than 110% of this 

mass).   

5,   Dissolve the sample in ~75-100 mL of water and use the stir bar to moderately stir the solution.  What 

piece of glassware is suitable for measuring this volume?   

6. Is this volume needed in the calculations?   Explain. 

7. While the acid sample dissolve, follow the steps in given in Appendix II which show how to use the 

Microlab pH probe and drop counter (video tutorial). 

8. How do you calculate the volume delivered by the drop counter?  

9. After dissolution, immerse the pH probe into the solution and adjust the magnetic stirrer so that the 

stir bar does not hit the pH probe.       

10. Start the experiment.  Stop the titration once the pH ‘levels’ out or plateaus at ~pH 10.   Ask your TA 

if you are unsure.  Inspect your graph to make sure it is of good quality.   

11. Save your data in a CSV format or text format from the MicroLab software.     

12. On the eLC lab site download and then run the EXCEL file ‘Decimate Titration Data for CurtiPlot’.   

13. Load the CSV or text file you saved from the MicroLab software into EXCEL as well.  

14. Follow the directions given in the ‘Decimate Titration Data for CurtiPlot’ EXCEL file.  It can be 

found under content in the ‘Calculations/Titration Curve Simulations’ folder on eLC.  Directions on 

how to decimate are included in the EXCEL file.   A tutorial on this is also provided on eLC. 

15. Once you have decimated your data, load CurtiPlot in EXCEL (when you load the file you may have 

to click the yellow Enable Editing button and then the Enable Content button). 

16. Click on the Evaluation tab.  The top of the sheet should say “Evaluation of Real and Simulated 

Titration Data by Derivatives and Interpolation.”    On the left-hand side of the sheet, look for the 

columns named Volume and pH.   Delete any data in these first two columns starting at row 6 by 

clicking on the ‘Clear’ button or by manual deleting the data with your mouse.   Copy the decimated 

volume and pH data for the titration into the Volume and pH columns of the Evaluation sheet. 

17. Click the ‘process’ button.  If the endpoint does not show up, change the ‘Detector Threshold’ down 

by 0.1 increments and reprocess until you see the endpoint. 

18. After processing, you are given the endpoint volumes and the first and second derivative data (on the 

right of the sheet).  You can copy this data to an EXCEL worksheet in a another file and name based 

on the titration sample you acquired  A tutorial for these analysis steps is also on eLC. 

19. Use the endpoint volume to find the millimoles of NaOH used. 

20. Find the millimoles of the acid unknown titrated. 

21. Find the molar mass of your acid. 

22. Go back and repeat the calculation is step 3 with this new molar mass.  

23. Get three clean, labeled beakers.  Weigh out three samples of your acid with the mass you calculated 

in step 22.    Again, weigh this mass to 4 decimal places (don’t weigh less than the mass or greater 



than 110% of this mass).   NOTE: if you had trouble dissolving the mass from the initial steps, do not 

use any higher mass.  You may want to reduce the mass slightly.  You can still predict the endpoint 

volumes. 

24. You will use a different indicators for each of the three titrations you are about to do.   You should 

familiarize yourself with the color changes of the indicators and the pH values over which they occur 

(see your book).  Record the drop count where the color completely changes, i.e. for bromothymol 

blue that is the drop count that the color transition from yellow to pure blue).  Find the volume that 

corresponding to this drop count and determine if this is close to the endpoint volume (inflection 

point) for the titration.. This will indicate if the indicator can be used. Some may exhibit more than 

one color change during the titration.  

25. Add the indicators to the samples.  Repeat steps 3 through 21 for each sample and gather the data in 

your EXCEL file and calculate the mean, standard deviation, %RSD and 95% confidence limits of the 

molar mass.  Use the real rule of significant figures. 

26. Examine the titration curves and find the pKa for your acid at 25%, 50% and 75% titrated.  How will 

you do this? 

27. Find the mean of all these pKa values and other statistics. 

28. Using pKa and molar mass data in your book, identify your unknown.  Set forth how you will prove 

this. 

 

QUESTIONS 
There are no questions for this experiment. 

  



FORMAL REPORT FORMAT EXPERIMENT #3: 

 I. HEADING -   

This includes the Title and the Author by-line.  See the “Lab Report Guidelines” and 

associated files on report formatting on eLC which can be found under course content. 

NOTE: Each section does not have to be on a separate page.  One section can follow 

another sequentially on a page unless an awkward break occurs. 

II. ABSTRACT -   

Follow the guideline for writing an abstract that can be found on eLC.   Make sure to 

identify your unknown by number in the abstract and in the report sections which follow.   

Your narrative should also include ACTUAL numbers summarizing your results, e.g. the 

mean value of a set of data along with its standard deviation and relative standard 

deviation and if available confidence limits.  All numbers should be reported using the 

“Real Rule” of significant figures found in your text. 

 III. INTRODUCTION: 

 It is critical that an introduction have correct citations.  Use credible sources and define 

terms as necessary for the experiment.   Things that should be covered include but are not 

limited to a 1) description of the chemistry during the titration of weak monoprotic acid, 

2) description of the apparatus that is used in the analysis, 3) a discussion of endpoint 

detection based on indicators and from potentiometric methods (second derivatives).  and 

3) reasons why such an analysis is performed.   Please make sure to do a thorough 

introduction, erring more on the three (3) paragraph side.  1 page should be sufficient for 

this, as you have plenty of things to potentially discuss. 

 IV. PROCEDURE: 

  See “Lab report Guidelines” on eLC. 

 V. RESULTS  

At some point in the results section you should show a graph of your best titration curve 

and how it was aquired. 

Summarize the data you gathered from the ‘rough’ titrations of your acids (Part I).  In 

narrative form, explain how you arrived at the conditions you used for your three final 

titration curves. 

Using a narrative style to fit in this section, you can insert answers to inquiry questions 

into the discussion (do not write the questions and answer them). 



Summarize and present the quantitative data and the indicator data for the three titrations 

along with statistics.  Give a short description of how it was acquired.  

 

 

VI. DISCUSSION 
Here you will discuss your results previously presented.  The discussion should present a 

complete analysis the data leading to the identity of your unknown.  Use your statistics to 

your advantage especially if you have narrowed it down to two acids.  

You should also discuss, in detail, the each indicator’s suitability to act as a visual 

indicate in a titration of your acid. 

You can also discuss improvements or issues with the current procedure/apparatus. 

 VI. CONCLUSION: 

 Summarize your results for the lab.  Follow the “Lab report Guidelines” and include 

actual numbers, similar to your abstract. 

 You will be graded on accuracy! 

 VII. SAMPLE CALCULATIONS 

 You should give examples of how you did all of your calculations for mass of the acid 

used and the molar masses.  You do not need to show the calculation of the mean and 

standard deviation, but do show how you arrived at your confidence limits. 

Don’t forget units and significant figures. 

VIII. REFERENCES: 

 ACS style references should be used with correct in text citations as necessary.  See 

https://pubs.acs.org/userimages/ContentEditor/1246030496632/chapter14.pdf 

 IX. APPENDIX 

 Include a printout of all EXCEL worksheets.  Also include the carbon copies for this 

experiment from your lab notebook. 

  



 

APPENDIX I 
The theoretical curve for the titration of a weak acid with a strong base can be calculated from the 

equation shown below.  This equation involves assumptions, which tend to break down near the 

beginning of the titration and near the equivalence point. 

 

  ( )

bb

abbaa

VC

KVCVC
H

-
=+

      (18) 

At 25 % titrated, (CaVa - CbVb) = 3 CbVb, and we get 

  aKH 3%25 =+

       (19) 

At 75 % titrated, (CaVa - CbVb ) = CbVb/3, and we get 

  aKH
3

1
%75 =+

       (20) 

Converting eq.19 and 20 to logarithms 

aKpH log-3log-%25 =
      (21) 

 

( ) aKpH log-31log-%75 =
      (22) 

Subtracting eq.21 from eq.22 

( ) 954.03log23log31log-- %25%75 ==+== pHpHpH
  (23) 

 

  



APPENDIX II 

Instructions for Recording a Titration Curve with a MicroLab pH electrode manually 

NOTE: The TA will show you how to calibrate your drop counter. 

1) Prepare a pH probe, 3 - 5 mL beakers, a medium sized beaker and a squirt bottle filled with DI 

water.   

2) Fill the first beaker with pH 4 buffer (red), the second with pH 7 buffer (yellow), and the last one 

with pH 10 buffer (blue). 

3) Make sure that the MicroLab box is powered on. 

4) Open “MicroLab”, you will be presented with different types of experiments. 

5) The default option will be “MicroLab Experiments”, press OK. 

6) Press “Add Sensor” around the middle-left of your screen. 

7) From the drop-down menu, choose counter. 

8) Click on the red box overlaid on the image of the front of the box. 

9) Click on the “Set counter options>” button.    At the new dialog box select the “Continually 

increasing count minus 1 (use for titrations)” button. 

10) Press “Finish.” 

11) Press “Add Sensor.” 

12) From the drop-down menu choose pH / D.O. 

13) Plug in your pH probe into the BNC connection that is highlighted with red box. 

14) Click on the red box. 

15) Select pH from the radio buttons. 

16) Press “Calibrate Sensor.” 

17) Press “Perform Calibration.” 

18) Submerge your pH probe into one of the pH buffers.  Remember Red = pH 4, Yellow = pH 7 and 

Blue = pH 10. 

19) Press “Add Calibration Point” on upper-left of the menu. 

20) When the red bar under “Sensor History” stabilizes, write down the pH of your buffer into the 

“Actual Value” and press “OK”.  Watch out for spikes in the data.  Don’t press “OK” when it 

spikes! 

21) Repeat procedure using the other two buffers. 

22) You can right click on a data point to remove it. 

23) Choose “First Order (Linear)” on the middle-left of the menu, confirm the validity of the 

calibration by checking the coefficient of variation value, R2. Press “Accept and Save This 

Calibration”. 

24) Save your calibration file on the desktop. 

25) Press “Finish”. 

DROP COUNTER CALIBRATION  

26) You will now calibrate your drop counter.  Set up the drop counter and reservoir as indicated by 

your TA.  Fill the reservoir with distilled water. 

27) Weigh an empty dry beaker. 



28) Drop about 100 drops through the drop counter.  Get the exact number from the starting and 

ending count on the screen. 

29) Weigh the beaker (no fingers on it!) and find the volume of water dispensed.  Then calculate the 

volume (in mL) per drop.  

END OF DROP COUNTER CALIBRATION 

30) Click “Add Formula.” 

31) Click on the ‘Counter Cnt” in the variables box. 

32) Click on the multiply, x, button. 

33) Enter the value of the mL per drop you got when you calibrated your drop counter (if you skipped 

the calibration as indicated by your TA, use 0.037 mL per drop). 

34) Enter the label “Volume” and units of “mL.” 

35) Press “OK.” 

36) You should see ‘Counter Cnt’ under sensor on the top-left of the window.  Click and drag ‘Counter 

Cnt’ to Column A of the spreadsheet table. 

37) You should now see Volume under formulas (top-left of window).  Click and drag the Volume to 

the X-axis of the plot.  Click and drag it to column B of the table. 

38) You should also see “pH” under “SENSOR” on the top-left of your screen.   Drag the “pH” to the Y-

axis of the plot.  Also, drag it to column C, and blank box on the bottom-right of your screen. 

39) You can now fill your drop counter reservoir with titrant and get the drop rate correct (see TA). 

40) You should also be ready to the pH probe in your sample (with stir bar) under the drop counter. 

41) In the lower left hand window you will see ‘Experiment Steps.’  Double click on the ‘Repeat Every 

0.500 seconds’ step.  In the dialog select ‘Repeat when counter change’ and press ‘OK.’ 

42) Now everything is setup and ready to go! 

43) Press “Start” on left-middle of your screen, it is under “Add Sensor”. 

44) Titrate your weak acid solution until the pH plateaus out somewhere above pH 10. 

45) Press “Stop” when titration is complete. 

46) Press “Analyze” under your graph and choose “Plot a Derivative (Rate of Change) [3rd choice]. 

47) Press “OK”, and press “OK.” 

48) Repeat steps 30 and 31 but choose “Plot Second Derivative” [4th choice] instead. 

49) Press and drag “DV” under your sensors onto column C. 

50) Press and drag “DDV” under your sensors onto column D. 

51) Press File  -> Export data -> Comma-Separated-Value text file and save on the desktop 

52) To repeat the titration, press “Repeat Experiment” next to the “Start” button, and choose 

“Repeat experiment without saving data” [3rd option]. 

  



APPENDIX III: 
Instructions for Plotting Excel Titration Curves 

1. Run Excel. 

2. Go to the File menu and select Open.  Select CSV as the file type.  Then select a 

Microlab comma delimited (CSV) file containing your titration data.   You can click 

through any dialog selections that appear and you may have to click Finish to load the 

file. 

3. When you look at the data - Column A should have the drop number, Column B the 

volume and Column C the pH.  You may also have a column with the calculated 

second derivative.   

4. Save this file as an EXCEL workbook. 

5. Highlight all the data in Columns B and C. 

6. Click on the Insert menu and click on the Scatter plot icon. 

7. Click on the smooth line type (scatter with data points connected by smooth lines 

with no markers). 

8. A scatter plot will appear on the sheet.  Right click on the plot and select ‘Move to.’ 

9. Select ‘New sheet’, give it a name and press OK.  The plot will appear as a new sheet 

in the workbook.  You can tab back and forth between your data and the plot at will. 

10. Double click on either of the axis labels and you can set the all of the axis options.  

Set these values to show off your data well. 

11. When you are in a chart, the tool bar has a ‘Chart Tools’ section.  Under layout, you 

can edit or add different things to your graph.  You should add axis titles, a chart title 

and a legend.  Please explore these options to make your graph look professional. 

12. If you have more than one data series plotted, you can set the line style for each using 

the Layout menu as well.  You can also add a legend.  Just don’t forget to name each 

data series (edited from the layout menu!) 

13. Alternatively, you can select the plot, copy, and paste it into a ''Word" document, and 

print the plot from within the word document. 

14. Scaling a Plot - You may scale the plot to exhibit only those portions of a scan that 

are significant to your experiment. 

15. You can have EXCEL print the chart alone using the print dialog. 

16. You can also select the plot and copy it.  You can then paste it into any other problem 

like Word as an EXCEL object or do ‘paste special’ an image (recommended). 

  



Acid Structure pKa M.W./g mol-1 

    

Fumaric acid 

  

3.03 

4.44 

116.07 

    

L-(+)-Glutamic acid 

 
 

2.19 

4.25 

9.67 

147.13 

    

Glutaric acid 
 

4.34 

5.41 

132.11 

    

p-Hydroxybenzoic acid 

 

4.57 138.12 

    

Iminodiacetic acid (IDA) 
 

2.98 

9.89 

133.10 

    

Isophthalic acid 

 

3.54 

4.60 

166.13 

    

Lactic acid 

 

3.90 90.08 
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Maleic acid 

 

1.92 

6.22 

116.07 

    

Malonic acid 
 

2.82 

5.66 

104.06 

    

Mandelic acid 

 

3.41 152.15 

    

Methyliminodiacetic 

CH3N(CH2COOH)2 

 
2.12 

9.65 

147.13 

    

Nitrilotriacetic acid (NTA) 

 

1.65 

2.94 

10.39 

191.14 

    

Oxalic acid 

 

1.27 

4.27 

126.07 
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O
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O
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Potassium hydrogen phthalate (KHP) 

KHC8H4O4 

O

OH

O

O

K
+

Potassium Hydrogen Phthalate (KHP)  

5.51 204.23 

    

Phthalic acid 

 

2.95 

5.41 

166.13 

    

Ascorbic acid 

 

 

4.10 

11.79 

176.12 

    

Succinic acid 
 

4.21 

5.64 

118.09 

    

Sulfamic acid 

 

2.0 97.09 

    

Sulfanilic acid 

 

3.23 173.19 

    

Tartaric acid 

 

4.37 150.09 

    

CO 2 H

CO 2 H

OH

OHO

OHHO

O

H

R
S

HO 2C CO 2 HCH 2 CH 2

S NH 2

O

O

HO

HO 3S

NH 2

HO 2C

CO 2H

OH

OH

R
R



 

Hydroquinone 

 

5.33 110.11 

    

Salicylic acid 

 

2.97 

13.74 

138.12 

    

Sodium Citrate 

Na3C6H5O7
.2 H2O 

 3.08 

4.74 

5.40 

294.10 

    

Sodium Oxalate 

Na2C2O4 

 1.27 

4.27 

134.00 

OH

HO

CO 2 H

OH


